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1 Introduction

The GTT RBS Test Suite is a SW-suite for anyone looking for the most efficient usage of
National Instruments RF-test HW for testing RBS related products. GTT has created a
versatile product suite that will help the users with everything from early verification to full
scale production testing. It gives You as a customer the starting point you need for your test
setup. GTT can of course assist you with optimization for your specific application.

2 GTT RBS Test Suite Overview

The GTT RBS Test Suite is built around a NI PXle chassis and NI LabVIEW. It consists of NI
LabVIEW toolkits for generating and analysing GSM, WCDMA, and LTE downlink signals
and supports NI RFSA and RFSG.

The GTT RBS Test Suite also includes a test sequence example for a RBS Small Cell and a
module for implementing statistical testing.

2.1 GTT LTE RBS Toolkit

The GTT LTE RBS Toolkit supports both generation and analysis of LTE signals. Besides
the capability of analysing the downlink signal and generating uplink fixed reference signals
according to FRC A1-3 (both fully filled and with 25 RBs) for receiver testing, the toolkit also
comes with signal generation of downlink according E-UTRA test model (E-TM) 1.1, 1.2, 2,
3.1, 3.2, 3.3 for calibration and/or verification of the setup without a UUT..

The following measurements are supported by the toolkit:

Base station Output Power

Transmit ON/OFF power (PvT, only applied for E-UTRATDD BS)
- Frequency Error (Average Carrier Frequency Offset)

- Error Vector Magnitude (EVM)

- Occupied Bandwidth (OBW)

- Adjacent Channel Leakage Power Ratio (ACLR)

- Operating band unwanted emissions

- RS TX Power

- CCDF (PAR, 0.1%, 0.01%, 0.001%)

A more detailed description of the measurements is to be found in ref [1]. For supported
3GPP revisions, see appendix A.



2.2 GTT GSM RBS Toolkit
The GTT GSM RBS toolkit supports both generation and analysis of a GSM signals. Besides
the capability of analysing the downlink signal and generating uplink for receiver testing, the
toolkit also comes with signal generation of downlink for calibration and/or verification of the
setup without a UUT. The user frequency band can be set for the generated signal. The
following measurements are supported by the toolkit:
- Modulation Accuracy
- Transmit Power
- Output RF Spectrum

- Power Versus Time

A more detailed description of the measurements is to be found in ref [2]. For supported
3GPP revisions, see appendix B.

2.3 GTT WCDMA RBS Toolkit
The GTT WCDMA RBS toolkit supports both generation and analysis of WCDMA signals.
Besides the capability of analysing the downlink signal and generating a 12.2 kbps uplink
signal (TC1)for receiver testing, the toolkit also comes with signal generation of downlink
signal according to test model (TM) 1, 2, 5 and 6 for calibration and/or verification of the
setup without a UUT. The following measurements are supported by the toolkit:
- Base station Output Power
- Error Vector Magnitude (EVM)
- Frequency Error
- CPICH Power Accuracy
- Adjacent Channel Leakage Power Ratio (ACLR)
- Occupied Bandwidth (OBW)
- Spectrum Emission Mask (SEM)
- Peak Code Domain Error

- Relative Code Domain Error (CDR)

A more detailed description of the measurements is to be found in ref [3]. For supported
3GPP revisions, see appendix C.

2.4 GTT RBS Small Cell Test

The RBS small Cell Test is based on the GTT LTE RBS Toolkit described in section 2.1. The
LTE signal generation and analysis parts in the GTT LTE RBS Toolkit are called from the
National Instruments TestStand software, see section 6.4 for more information.



The small cell test comes with a tool for statistical testing. It can, using previously collected
data, decide if a certain test must be run or not to assure a set confidence level of the
product. This can greatly reduce test times where the product quality is high enough to allow
sample testing. See section for 6.5 for more information about the statistical add-on module.

3 System Requirements

See http://testteknik.se/content/product for a list of SW and HW requirements for the different
products.

4 Installation and Configuration

4.1 LTE RBS Toolkit
For version 1.0.1 or older:
Run the .. \GTT_LTERBS\Volume\ setup.exe
For version 1.1.0 or newer:

Start LabVIEW and VIPM with administrator rights and start the installation of the “LTE RBS”
using VIPM 2014 or newer.

The installer for the LTE RBS toolkit includes an installer for the NI LTE toolkit. During the
installation process both the LTE RBS toolkit and the NI LTE toolkit are installed. The NI LTE
toolkit will ask for a serial number, but it can be left blank. The license status for NI LTE
toolkit is overridden by the LTE RBS toolkit, i.e. no separate activation is required for the NI
LTE toolkit. See chapter 5.1 for more information.

The installed SFPs are by default located at:

32-bit Windows: C:\Program Files\Gefle Testteknik\LTE RBS
64-bit Windows: C:\Program Files (x86)\Gefle Testteknik\LTE RBS

The installed APIs are by default located at:

...\National Instruments\[LabVIEW InstallDir]\vi.lib\Gefle Testteknik\LTERBS\...

4.2 GSM & WCDMA RBS Toolkit
Run the ..\GTT_GSMWCDMARBS \Volume\ setup.exe
The installed SFPs are by default located at:

32-bit Windows: C:\Program Files\Gefle Testteknik\ GSMRBS
64-bit Windows: C:\Program Files (x86)\Gefle Testteknik\GSMRBS

32-bit Windows: C:\Program Files\Gefle Testteknik WCDMARBS
64-bit Windows: C:\Program Files (x86)\Gefle Testteknik\WCDMARBS

The installed APIs are by default located at:


http://testteknik.se/content/product

...\National Instruments\LabVIEW 2012\vi.lib\GefleTestteknik\ GSMRBS\...
...\National Instruments\LabVIEW 2012\vi.lib\GefleTestteknik\ WCDMARBS\...

4.3 GTT RBS Small Cell Test

Run the ..\GTT RBS Small Cell LTE\Installer\Volumel\setup.exe

5 Evaluation/Activation

The distributed executables and the GTT LabVIEW libraries (*.Ivlib) are licensed and have an
evaluation period of 30 days and must then be activated for continued use. The license is
locked to the computer that is used during installation.

When a product is to be manually activated (i.e. offline), send an email to
sales@testteknik.se in the following format:

Company Name:
User Name:

Executable User Code 1:
Executable User Code 2:

LabVIEW Library User Code 1:
LabVIEW Library User Code 2:

See more information below.

The evaluation/activation process is different depending on which product and version that is
used.

5.1 Evaluation/Activation for GTT LTE RBS version 1.1.0 or newer

Selection of Activation/Evaluation mode of the LabVIEW libraries and the executable is done
froma “Third Party Add-ons” dialog box inside LabVIEW. This one is shown
automatically when LabVIEW is started and can also be reached from following menu inside
LabVIEW: Help -> Activate Add-ons.

5.1.1 Evaluation

If Evaluation mode is wanted, no particular action is necessary. Simply click “Continue to
LabVIEW".

5.1.2 Online activation

Openthe “Third Party Add-ons” dialog box inside LabVIEW and select “Activate
Add-ons”. In the next dialog box, select the GTT toolkit you wish to activate and press
“Next”. In the next Dialog box, select “Automatically activate through an
Internet connection” and press “Next”. In the next dialog box enter the LicenselD and
password you got when you bought the product and press “Activate”.


mailto:sales@testteknik.se

5.1.3 Offline activation

Openthe “Third Party Add-ons” dialog box inside LabVIEW and select “Activate
Add-ons”. In the next dialog box, select the GTT toolkit you wish to activate and press
“Next”. In the next Dialog box, select “Use a Web browser on this or another
computer to acquire an activation code” and press “Next”. In the next dialog
box, send these two “LabVIEW User Codes” to sales@testteknik.se, using the mail template
above. GTT will send back two activation codes. Copy these two into the Activation Code 1
and 2 and press “Activate”.

5.2 Evaluation/Activation for other LTE versions and GSM/WCDMA products

5.2.1 The GTT executables

5211

521.2

As long as a GTT executable is not activated, a dialog box is shown each time the
executable is started. In this dialog box the user can select “Evaluation” or “Activate”.

Evaluation

If Evaluation mode is wanted, no particular action is necessary. Simply click “Evaluation”
to run the application in evaluation mode.

Activation

If a license is purchased, select “Activation” and a new dialog is shown with two User
Codes. Send these two “Executable User Code” to sales@testteknik.se, using the mail
template above. GTT will send back two activation codes. Copy these two into the Activation
Code 1 and 2 and press “Continue”.

5.2.2 The GTT LabVIEW libraries

5.2.21

5.2.2.2

Selection of Activation/Evaluation mode of the LabVIEW libraries is done from a “Third
Party Add-ons” dialog box inside LabVIEW. This one is shown automatically when
LabVIEW is started and can also be reached from following menu inside LabVIEW: Help ->
Activate Add-ons.

Evaluation

If Evaluation mode is wanted, no particular action is necessary. Simply click “Continue to
LabVIEW".

Activation

If a license is purchased, select “Activate Add-ons”. In the next dialog box, select the
GTT toolkit you wish to activate and press “Next”. In the next Dialog box, select “Use a
Web browser on this or another computer to acquire an activation
code” and press “Next”. In the next dialog box, send these two “LabVIEW Library User
Code” to sales@testteknik.se, using the mail template above. GTT will send back two
activation codes. Copy these two into the Activation Code 1 and 2 and press “Activate”.
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6 Using GTT RBS Test Suite

6.1 GTT LTE RBS Toolkit

6.1.1 Soft Front Panel Settings

The LTE soft front panel is started from Windows Start -> Program -> Gefle Testteknik ->
LTE RBS -> LTERBS.

The SFP window appears:
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lFigure 6-1: Settings Tab

6.1.1.1 Acquisition section

% VST
RFSA name:
OnbeoardClock

Clock source:

[ |

Analysis device, VST in this case.

Reference clock source to the VST on board PLL (Phase Lock

Loop).




On board clock — Selects internal 20 MHz clock
Ref In — Selects reference clock in front.

PXI Clock 10 — Selects 10 MHz clock from the PCI Express
backplane.

ClkIn — This configuration does not apply to the NI
5644R/5645R (See NI documentation for more information).

Center Frequency
j 213246
Reference Level (dBm)
'l"l
7’
External Attenuation (dE)
J-'ll
o’
Auto Level
L |
o Falze

Figure 6-2: RFSA Settings

RFSA settings:
Center Frequency: Center frequency of the LTE signal.
Reference Level: LTE signal reference level

External Attenuation, dB:  Attenuation in the signal path that must be taken in notice.

Auto Level: If true, the system sets the best reference level based on the
peak power of the measured signal. If false, the value in the
Reference Level settings is used.

Duplex Mode DL

:—J DL (FDD)

Systemn Bandwidth DL

::) 10M
Downlink Test Model

:;."II E-TM3.1

Figure 6-3: LTE Signal Settings

LTE signal settings:

Duplex Mode DL.: Selects if the Down Link (DL) signal to be analysed is FDD or
TDD mode.
System Bandwidth DL: Selects the bandwidth of the DL signal to be analysed.

Downlink Test Model: Selects the test model of the DL signal to be analysed.
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Figure 6-4. Advanced Settings

Advanced Settings:

Measurements offset (slots): Set on which slot the analysis of the signal shell start.

Number of averages:
Measurement length (slots):
Cell ID:

EVM measurement unit:

# of Antennas:

Preferred Sync Method:

Sync Signal Port:

ACP Sweep Time (sec):

Set the number of averages that should be analysed.
Set how many slots the analysis should be performed at.
Sets the Cell ID of the signal.

Selects if the result should be presented in % or dB.

Specifies the number of antennas used for the
transmission/reception of the LTE signal.

Specifies the antenna ports on which the P-SS and the S-SS
are transmitted.

Specifies the antenna ports on which the P-SS and the S-SS
are transmitted.

Sets the measurement length for ACP.

SEM Measurement Length (sec): Sets the measurement length for SEM.

SEM Meas Results Type:

SEM All Traces Enabled:

Specifies the type of the measurement results for the SEM
measurement, Total Power Reference or Power Spectral
Density Reference.

Specifies whether to enable all the traces SEM measurement.
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Figure 6-5: BS Settings for Unwanted emissions

BS Settings for Unwanted emissions: settings for the SEM measurement see ref [1] for
details of what settings is suitable for the UUT.

ModAcc
CCDF
PwT
CHP
OBW
[V] ACP
SEM

Figure 6-6: Enable

Enable: enable which measurements to perform.

Figure 6-7: Message
Message: displays all errors and warnings.

6.1.1.2 Generation section

[ 11213246 ﬂ

Center Frequency (Hz): Center frequency of the LTE signal.

s .

B
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Figure 6-8: Trigger Config

Trigger Config:

Type:

Source:

Edge:

PFI Min Pulse Width:

Start Trigger Delay:

Read From File

Sets the signal output level. The actual signal level is the
power level plus the external attenuator.

Generation device, VST (PXle-5644/5645R) is required for
generation.

Specifies the AWG pre-filter gain.

Immediate — No start trigger is configured.
Start Trigger — Enables trigger functionality.

Restart Trigger — This will restart the capturing of the trigger
and signal generation. Note: Start Trigger Delay must be set
to at least 10 us.

Trigger input select. PFIO-2 is valid for PXI-5644/5645R. PFO
is located at the front of the VST, PF1 and PF2 on digital 1O
connector.

Rising edge/Falling edge, selects on which edge the trigger
shall be detected.

Specifies the minimal pulse width in seconds for the PFI lines.

A configurable trigger delay up to 35 seconds before the
generation starts.



Generation mode:

Read From File:

File Settings
Path

3 =]

~Sam;:nlva: rate file

A

Figure 6-9: File Settings
Path:
Sample rate file:

UL Generate:

UL Generate

Systern Bandwidth (Hz) Uplink FRC
=[a1-3

Baseband Filter Enabled Uplink RNTI

10m [~]

E |Fa|se | 0
EZeII Id ‘ \Fulhr Filledl
| =

buplex rriode UL
UL (FDOY

Figure 6-10: UL Generate Settings

System Bandwidth (Hz):
Basband Filter Enabled:
Cell ID:

Duplex mode UL:
Uplink FRC:

Uplink RNTI:

Fully filled:

DL for loopback:

Select to read IQ data from a file. The file format should be
TDMS and it should be interleaved 1Q format, i.e. first column
with | and second with Q.

Select the 1Q file to be used.
Set the sample rate for the IQ data in the file (ex 15.36M).

Build the uplink signal to generate.

Resource Elernent hap UL
600

500-
400 -

300-

200-

Fesource Elerments

100-

1 I | |
1] 20 40 &0 a0 100 120 140
Sernbols

Set the bandwith of the signal, 1.4MHz - 20MHz.
Enable baseband filter.

Sets the Cell ID of the signal.

Sets the duplex mode of the signal, FDD or TDD.
Select FRC model, A1-1 — A1-5.

Set the RNTI of the signal.

Select if the FRC A1-3 should fully filled or have 25RBs.

Available for testing the whole system, using a loop cable
between RF out and RF in.
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Figure 6-11: DL for loopback Settings
6.1.2 Soft Front Panel Measurement Results
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lFigure 6-12: Measurement Results tab.



6.1.3 Measurement definitions according to 3GPP

6.1.3.1

6.1.3.2

6.1.3.3

6.1.3.4

6.1.3.5

6.1.3.6

6.1.3.7

6.1.3.8

Base station output power (Channel Power in SFP)

The test purpose is to verify the accuracy of the maximum output power across the
frequency range and under normal and extreme conditions for all transmitters in the BS.

Frequency error (Average Carrier Frequency Offset in SFP)

Frequency error is the measuring of the difference between the actual BS transmit frequency
and the assigned frequency. The same source shall be used for RF frequency and data clock
generation.

EVM (Error Vector Magnitude)

The Error Vector Magnitude is a measure of the difference between the ideal symbols and
the measured symbols after the equalization. This difference is called the error vector. The
EVM result is defined as the square root of the ratio of the mean error vector power to the

mean reference power expressed in percent.

DL RS power (RX TX Power in SFP)

DL RS power is the resource element power of Downlink Reference Symbol.
Occupied bandwidth (OBW Spectrum Trace in SFP)

The occupied bandwidth is the width of a frequency band such that, below the lower and
above the upper frequency limits, the mean powers emitted are each equal to a specified
percentage (/2 of the total mean transmitted power.

The test purpose is to verify that the emission of the BS does not occupy an excessive
bandwidth for the service to be provided and is, therefore, not likely to create interference to
other users of the spectrum beyond undue limits.

Adjacent Channel Leakage power Ratio (ACP relative power in SFP)

Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the filtered mean power
centred on the assigned channel frequency to the filtered mean power centred on an
adjacent channel frequency.

Operating band unwanted emissions (SEM measurements in SFP)

This test measures the emissions of the BS, close to the assigned channel bandwidth of the
wanted signal, while the transmitter is in operation.

Complementary Cumulative Distribution Function (CCDF measurements in SFP)

This test measures the complementary cumulative distribution function (CCDF) of the RF
signal, peak power and average power.



6.2 GTT GSM RBS toolkit

6.2.1 Generation Soft Front Panel

The soft front panel for GSM signal generation is started from Windows Start -> Program ->
Gefle Testteknik -> GSMRBS -> GSMRBSGen.

The generation window appears:

RF5G Handle In

% RF5G ﬂ Trigger Config . Generation in Progress
External Attenuation, dB Type

n
!

-:J 0,00 |Immediate | Frequency Reference
Average Power, dBrn .
j 0,00 Source Reference Source 2 On Board Clock
LI'I'I' settings PFI0 Frequency, Hz :-J 10,000000E+G
uuT I%dge Backplane Source :j Mone

,‘J M5 :—J Rising Edge

: Band Advanced Settings Generate

3 PGSM PFI Min Pulse Width Signal

ARFCN 0 (= ]
A I =l MEBEslatD
-j a Start Trigger Delay . .
30

Figure 6-13: the GSM signal generation front panel

There are a number of settings for the signal generation:

RF5G Handle In
% VST =

RFSG Handle In: Generation device, VST (PXle-5644/5645R) is required for
generation.

External Attenuation, dB

.

bl 0,00

External Attenuation, dB:  Attenuation in the signal path that must be taken into account.

A;.rerage Power, dBrn

"

bl 0,00

Average Power, dBm: Sets the signal output level. The actual signal level is the
power level plus the external attenuation.
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Figure 6-14: UUT settings

UUT settings:

UUT:

Band:

ARFCN:

Type

Immediate |

Source

PFI0
Edge
:—j PFID
Advanced Settings
PFI Min Pulse Width

L
Start Trigger Delay
L
Figure 6-15: Trigger settings
Trigger settings:

Type:

Source:

Edge:

PFI Min Pulse Width:

Select UUT, BTS = Base Transceiver Station, MS = Mobile
Station.

Selection of the GSM frequency band.

Absolute Radio Frequency Channel Number. The interval of
this number depends on the frequency band.

Immediate — No start trigger is configured.
Start Trigger — Enables trigger functionality.

Restart Trigger — This will restart the capturing of the trigger
and signal generation. Note: Start Trigger Delay must be set
to at least 10 us.

Trigger input select. PFIO-2 is valid for PXI-5644/5645R. PFO
is located at the front of the VST, PF1 and PF2 on digital IO
connector.

Selects which edge, rising or falling, on which the trigger
should be detected.

Specifies the minimal pulse width in seconds for the PFI lines.



Start Trigger Delay: A configurable trigger delay up to 35 seconds before the
generation starts.

Reference Source :-) On Board Clock

Frequency, Hz :-J 10,000000E+6
Backplane Source .’j Mone

Figure 6-16: Frequency reference settings

Frequency reference settings:

Reference Source: Reference clock source to the VST on board PLL (Phase Lock
Loop)

On board clock — Selects internal 20 MHz clock.
Ref In — Selects reference clock in front.

PXI Clock 10 — Selects 10 MHz clock from the PCI Express
backplane.

Frequency, Hz: When the reference source above is set to “Ref In” this
parameter sets the frequency of the incoming clock.

Backplane Source: Sets the signal to drive the 10 MHz reference clock in PXI

backplane. This functionality is only supported for PXI-5610,
PXI1-5670 and PXI-5671.

Generate

Signal

= NBsloto

Figure 6-17: Generate
Generate:
Signal: NB slot 0 — Normal burst for slot O, all other slots idle data.
NB slot 1 — Normal burst for slot 1, all other slots idle data.
NB all slots — Normal burst for slot 0-7.

From file:



File
Generation File Path (ASCI)

ChUsers\GT TDocumentsi I -filesh, El
8 EDGE_1slot_TSCO_FslO0MHz.wf.ascii

;1II
Sample rate o 10M

Figure 6-18: File
Path: Path to 1Q file.

Sample rate: Signal sample rate.

To start the generation of the GSM signal, press the symbol. If the green LED in the front

panel is enabled the generation has started. To stop the generation, press the | _EECE

symbol. If a setting is changed during generation, the [ Updte

apply the changes.

. symbol must be pressed to

6.2.1.1 Analysis Soft Front Panel

The soft front panel for the GSM signal analysis is started from Windows Start -> Program -
> Gefle Testteknik -> GSMRBS -> GSMRBSAnalysis.

The analysis window appears:
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RF54 Handle In T¥P Measurement

B RFSA =l

RFSA Settings
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BS settings
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Figure 6-19: Soft front panel analysis window

ORFS

6.2.1.2 Front panel settings

To the left in the soft front panel the settings pane appears and to the right the results of the
different measurements. There are a number of settings for the signal generation:

RFE& Handle In

5 v H

RFSA Handle In: Analysis device: VST in this example.
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Figure 6-20: RFSA settings

RFSA settings:
Center Frequency: Center frequency of the GSM signal.
Reference Level: GSM signal reference level

External Attenuation, dB:  Attenuation in the signal path that must be taken into account.

Auto Level: If true, the system uses the best reference level based on the
peak power of the signal measured. If false, the value in the
Reference Level settings is used.

BS settings
uuT
:;:l ETS
Band
:—jl PGSM
ARFCM
J o
Burst Sync
:j Training Sequence
Averages

Figure 6-21: BS settings

BS settings:

UUT: Select UUT, BTS = Base Transceiver Station, MS = Mobile
Station.

Band: Selection of the GSM frequency band.

ARFCN: Absolute Radio Frequency Channel Number. The interval of

this number depends on the frequency band.



Burst Sync: Method to synchronize to the data burst. Can be set to None
(no sync), Amplitude (-20 dB threshold) or Training sequence.

Averages: On/Off, if set to On the number of averages is set to 200 (this
setting is valid for OFRS and EVM measurements)

Frequency Reference settings:

Frequency Reference

Feference Source f.) On Board Clock

Frequency, Hzf/  10,000000E +6
Backplane Source :;;l Mane

Figure 6-22: Frequency Reference settings

Reference Source: Reference clock source to the VST on board PLL (Phase Lock
Loop)

On board clock — Selects internal 20 MHz clock
Ref In — Selects reference clock in front of the VST

PXI Clock 10 — Selects 10 MHz clock from the PCI Express
backplane.

Frequency, Hz: When the reference source above is set to ‘Ref In’ this
parameter sets the frequency of the incoming clock.

Backplane Source: Sets the signal to drive the 10 MHz reference clock in PXI
backplane. This functionality is only supported for PXI-5610,
PXI-5670 and PXI-5671.

Trigger
Source ::J Irmrmediate
Edge ::J Rising
Delay, sec ::J 0,00E+0
Lewel, dBm ::J -20,0
hin Quiet Time, sec ::J 0,00E+0

Figure 6-23: Trigger settings
Trigger settings:
Source: Immediate — No triggering is used
External — Not used
Software — Not used
RTSIO-7 — PXI trigger 0-7

PFIO-2 — PFIO in the front of PXle-5644R, PFI1-2 in the
backplane.



6.2.1.3

Power — Power level trigger (Level parameter below)

Edge: Selects which edge, rising or falling, on which the trigger shall
be detected.

Delay, sec: Specifies the time between the trigger event and the start of
data acquisition.

Level, dBm: The level to use for power triggering (includes any external
attenuation).
Min Quiet Time, sec: Specifies the minimum time the signal must remain below the

trigger level in order for the trigger to work.

To start a capture of a WCDMA signal, press the symbol.
Front panel measurements

The measurements results will be found in the different front panel tabs:

EVM, modulation accuracy measurements
- TXP, Transmit Power measurement

- ORFS, Output RF Spectrum measurement
- PvT, Power versus Time measurements

In section 6.2.2 below there is a more detailed description of each measurement.

6.2.2 Measurement definitions according to 3GPP

6.2.2.1

6.2.2.2

Mean Transmitted RF Carrier Power (TXP tab in SFP)

To verify the accuracy of the mean transmitted RF carrier power across the frequency range
and at each power step.

Modulation accuracy EDGE (EVM tab in SFP)

The test purpose is:
1. To verify the correct implementation of the pulse shaping filtering.

2. To verify that at GMSK modulation the phase error during the active part of the time slot
does not exceed the specified limits under normal and extreme test conditions and when
subjected to vibration.

3. To verify that the frequency error during the active part of the time slot does not exceed
the specified limits under normal and extreme test conditions and when subjected to
vibration.



4. To verify that at supported modulations 8-PSK, QPSK, AQPSK, 16-QAM and 32-QAM
the Error Vector Magnitude (EVM) and the origin offset during the active part of the time
slot do not exceed the specified limits under normal and extreme test conditions and
when subjected to vibration.

Note: All TRXs in the configuration shall be switched on transmitting full power in all time
slots for at least 1 hour before starting the test.

6.2.2.3 Transmitted RF carrier power versus time (PvT tab in SFP)
The test purpose is to verify:

1. The time during which the transmitted power envelope should be stable (the useful part
of the time slot);

2. The stability limits;
3. The maximum output power when nominally off between time slots.

6.2.2.4 Spectrum due to modulation and wideband noise (ORFS tab in SFP)

The purpose of this measurement is to verify that the output RF spectrum due to modulation
and wideband noise does not exceed the specified levels for an individual transceiver.

The system under test shall be tested with one TRX active or with the BTS equipped with
only one TRX, at three frequencies (first at RF channel B, second at RF channel M and third
at RF channel T). Slow frequency hopping shall be disabled.

6.2.2.5 Switching transients spectrum (ORFS tab in SFP)

The purpose of this measurement is to verify the level of the switching transients in the
output RF spectrum.

6.3 GTT WCDMA RBS toolkit

6.3.1 Generation Soft Front Panel

The soft front panel for WCDMA signal generation is started from Windows Start ->
Program -> Gefle Testteknik -> WCDMARBS -> WCDMARBSGen.

The generation window appears:
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Figure 6-24: the WCDMA signal generation front panel

There are a number of settings for the signal generation:

RF5G Handle In
% VST =

RFSG Handle In: Generation device, VST (PXle-5644/5645R) is required for
generation.

External Attenuation, dB

.

bl 0,00
External Attenuation, dB:  Attenuation in the signal path that must be taken into account.

Average Power, dBm

"

bl 0,00

Average Power, dBm: Sets the signal output level. The actual signal level is the
power level plus the external attenuator.

Center Frequency, Hz

.

5 1000000000

Center Frequency, Hz: Carrier frequency set.
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Figure 6-25: Trigger settings

Trigger settings:

Type:

Source:

Edge:

PFI Min Pulse Width:

Start Trigger Delay:

Immediate — No start trigger is configured.
Start Trigger — Enables trigger functionality.

Restart Trigger — This will restart the capturing of the trigger
and signal generation. Note: Start Trigger Delay must be set
to at least 10 us.

Trigger input select. PFI0-2 is valid for PXI-5644/5645R. PFO
is located at the front of the VST, PF1 and PF2 on digital IO
connector.

Rising edge/Falling edge, selects on which edge the trigger
shall be detected.

Specifies the minimal pulse width in seconds for the PFI lines.

A configurable trigger delay up to 35 seconds before the
generation starts.

Reference Source .‘.) On Board Clock

Frequency, Hz :-J 10,000000E+6

Backplane Source :—J Mane

Figure 6-26: Frequency reference settings

Frequency reference settings:

Reference Source:

Reference clock source to the VST onboard PLL (Phase Lock
Loop)

Onboard clock — Selects internal 20 MHz clock.

Ref In — Selects reference clock in front.



PXI Clock 10 — Selects 10 MHz clock from the PCI Express
backplane.

Frequency, Hz: When the reference source above is set to “Ref In” this
parameter sets the frequency of the incoming clock.

Backplane Source: Sets the signal to drive the 10 MHz reference clock in PXI
backplane. This functionality is only supported for PXI-5610,
PXI-5670 and PXI-5671.

Generate
Signal Scramble Code
a 3l
g™ g

Figure 6-27: Generate

Generate:

Signal: Signal type. TM1, TM2, TM5 or TM6 for downlink and TC1 for
uplink (12.2 kbps, DPCCH: SF = 256, Code = 0, -6.5 dBc,
DPDCH, SF = 64, Code = 16, -1.1 dBc, I).

Scramble Code: Scramble code number.

From file:

Generation File Path (ASCI)

ChUsers\GT ThDocumentsi IO -filesh, Ei
g EDGE_1slot TSCO_Fs10MHzowf.ascii

samnple rate :'_.,"II 10M

Figure 6-28: Generation file path

Path: Path to 1Q file.

Sample rate: Signal sample rate

To start the generation of the WCDMA signal, press the symbol. If the green LED in the

front panel is enabled the generation has started. To stop the generation, press the | LB
symbol. If a setting is changed during generation, the [ Upate | symbol must be pressed to

apply the changes.



6.3.2 Analysis Soft Front Panel

The soft front panel for WCDMA signal analysis is started via Windows Start -> Program ->

Gefle Testteknik -> WCDMARBS -> WCDMARBSAnalysis.

The analysis window appears:
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Figure 6-29: the WCDMA signal analysis front panel

6.3.2.1 Front panel settings

To the left in the soft front panel the settings pane appears and to the right the results of the

different measurements. There are a number of settings for the signal generation:

RF&A Handle In

ST =l

RFSA Handle In:

=i

Analysis device, VST in this case.
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Figure 6-30: RFSA settings

RFSA settings:

Center Frequency:
Reference Level:
External Attenuation, dB:

Auto Level:

BE settings
T

-

B3 rmaximurm output power, dBrm

-

Syrnbol Boundary

0

Center frequency of the WCDMA signal.

WCDMA signal reference level

Attenuation in the signal path that must be taken into account.
If true, the system sets the best reference level based on the

peak power of the signal measured. If false, the value in the
Reference Level settings is used.

:—JI Auto
Figure 6-31: BS settings

BS (Base Station) settings:

UUT:

BS maximum output power:

Symbol Boundary:

Frequency Reference settings:

Frequency Reference

Select if the UUT is a BS or UE (User Equipment)

Set the maximum output power for the UUT, needed to set the
correct SEM mask parameters.

Test channel selection: Auto, User or a specific test model.

Reference Source :-) O Board Clock

Frequency, Hz;:) 10,000000E +6

Backplane Source :ﬂ Maone

Figure 6-32: Frequency Reference settings



Reference Source:

Frequency, Hz:

Backplane Source:

Trigger
Source :—)
Edge :—)
Delay, sec :—)
Lewel, dBrm ;)
kdin Quiet Time, sec ;)

Figure 6-33: Trigger settings

Trigger settings:

Source:

Edge:

Delay, sec:

Level, dBm:

Min Quiet Time, sec:

Reference clock source to the VST onboard PLL (Phase Lock
Loop)

Onboard clock — Selects internal 20 MHz clock
Ref In — Selects reference clock in front.

PXI Clock 10 — Selects 10 MHz clock from the PCI Express
backplane.

When the reference source above is set to “Ref In” this
parameter sets the frequency of the incoming clock.

Sets the signal to drive the 10 MHz reference clock in PXI
backplane. This functionality is only supported for PXI-5610,
PXI1-5670 and PXI-5671.

Irmmediate
Rising
0,00E+0

0,00E+0

Immediate — No triggering is used
External — Not used

Software — Not used

RTSIO-7 — PXI trigger 0-7

PFI0-2 — PFIO in the front of PXle-5644R, PFI1-2 in the
backplane.

Power — Power level trigger (Level parameter below)

Rising/Falling, selects on which edge the trigger shall be
detected.

Specifies the amount of additional time after the trigger event
before acquire data.

The level to use for power triggering (includes any external
attenuation).

Specifies the minimum time below the trigger value the signal
must remain in order to trigger.



6.3.2.2

To start a capture of a WCDMA signal, press the symbol.

Front panel measurements

The measurements results will be found in the different front panel tabs:

- ACP (ACLR), Adjacent Channel Leakage Power measurements

- ModAcc (EVM), Modulation Accuracy measurements

- CDP, Code Domain Power measurements

- SEM, Spectrum Emission Mask

- CHP & OBW, Channel Power and Occupied Bandwidth measurements

In section 6.3.3 below there is a more detailed description of each measurement.

6.3.3 Measurement definitions according to 3GPP

6.3.3.1

6.3.3.2

6.3.3.3

6.3.3.4

Base station Maximum Output Power (CHP tab in SFP)

Maximum output power, Pmax, of the base station is the mean power level per carrier
measured at the antenna connector in specified reference condition.

The test purpose is to verify the accuracy of the maximum output power across the
frequency range and under normal and extreme conditions for all transmitters in the BS.

Primary CPICH Power accuracy (CDP tab in SFP)

Primary CPICH (P-CPICH) power is the code domain power of the Primary Common Pilot
Channel. P-CPICH power is indicated on the BCH. The requirement is applicable for all BS
types.

The purpose of the test is to verify, that the BS under test delivers Primary CPICH code
domain power within margins, thereby allowing reliable cell planning and operation.

Frequency error (ModAcc tab in SFP)

Frequency error is the measuring of the difference between the actual BS transmit frequency
and the assigned frequency. The same source shall be used for RF frequency and data clock
generation.

The purpose of this measurement is to verify that the Frequency Error is not too high.

Occupied bandwidth (OBW tab in SFP)

The occupied bandwidth is the width of a frequency band such that, below the lower and
above the upper frequency limits, the mean powers emitted are each equal to a specified
percentage B/2 of the total mean transmitted power.

The value of /2 shall be taken as 0.5%.



6.3.3.5

6.3.3.6

6.3.3.7

6.3.3.8

6.3.3.9

The test purpose is to verify that the emission of the BS does not occupy an excessive
bandwidth for the service to be provided and is, therefore, not likely to create interference to
other users of the spectrum beyond undue limits.

ACLR (ACP tab in SFP)

Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the RRC filtered mean power
centred on the assigned channel frequency to the RRC filtered mean power centred on an
adjacent channel frequency.

Peak code Domain error (ModAcc tab in SFP)

The Peak Code Domain Error is computed by projecting the error vector (EVM) onto the
code domain at a specific spreading factor. The Code Domain Error for every code in the
domain is defined as the ratio of the mean power of the projection onto that code, to the
mean power of the composite reference waveform. This ratio is expressed in dB. The Peak
Code Domain Error is defined as the maximum value for the Code Domain Error for all
codes. The measurement interval is one timeslot as defined by the C-PICH (when present),
otherwise the measurement interval is one timeslot starting with the beginning of the SCH.

It is the purpose of this test to discover and limit inter-code cross-talk.

Relative Code Domain Error (ModAcc tab in SFP)

The Relative Code Domain Error is computed by projecting the error vector (EVM) onto the
code domain at a specified spreading factor. Only the active code channels in the composite
reference waveform are considered for this requirement. The Relative Code Domain Error for
every active code is defined as the ratio of the mean power of the error projection onto that
code, to the mean power of the active code in the composite reference waveform. This ratio
is expressed in dB. The measurement interval is one frame.

The requirement for Relative Code Domain Error is only applicable for 64QAM modulated
codes.

EVM

The Error Vector Magnitude is a measure of the difference between the reference waveform
and the measured waveform. This difference is called the error vector.

Spectrum emission mask (SEM in SFP tab)

The mask defined in ref [3] may be mandatory in certain regions. In other regions this mask
may not be applied.

For regions where this clause applies, the requirement shall be met by a base station
transmitting on a single RF carrier configured in accordance with the manufacturer's
specification. In addition, for a BS operating in non-contiguous spectrum, the requirements
apply inside any sub-block gap.

This test measures the emissions of the BS, close to the assigned channel bandwidth of the
wanted signal, while the transmitter is in operation.



6.4 Small Cell Test

6.4.1 TestStand

TestStand is a test management software used to develop automated test systems. Test
sequences are used to call the different Vis to be able to generate and analyse signals.
Below is an example of a LTE test sequence. This example can be installed and tested, see
section 4 for further information how to install it.

6.4.1.1 Main test sequence

Open the TestStand software and select File -> Open file, and select the sequence file:
.\Installation directory\RBS Small Cell LTE\Small Cell LTE.seq.

Step
= Setup [2]

-;5@ Set up of multiplexer for bl DUT

Drezcription

F LTE signal should be generated?
<End Group:
= Main [13)
Fid Set number of test meazurements loops

E Load parameters for generation and analyziz for ...
Q‘g For

*2 If
Fid Staternent
"1 Additional Results

Load of 1zt configuration parameters for ge...

Load limits

~ Else
S Staternent
"1 Additional Results

Load of 2nd canfiguration pararmeters far g..

Load limits
% End

@ Signal analysiz initialize

@ Generate LTE signal and analyze
@ Cloze Analpsiz
% End
<End Group:
= Cleanup [1]
B Close Hw!
<End Group:

Figure 6-34: LTE test sequence example

Call MainSequence in HwSettings!

StationGlobalz. LteSiaGen=True

Localz. HumberQfT estLoops=2

Locals. TestLoopMumber = 0; Locals. TestLoopMu...

Localz. TestLoopMurmber==
Localz. Measlnfarmation=""Start of measurement lo...
Recordz 1 Additional Result(z]

Property Loader: File: ConfigurationtGenerationd. ..
Property Loader: File: TestlimitzhT estLimitsT . bt
Locals Measlnfarmation="5tart of measurement lo...
Recordz 1 Additional Result(z)

Property Loader: File: ConfigurationGenerationdm...
Property Loader: File: TestLimitzhT estLimite2 bt
Call MainSeguence in TestSettingzSeq.zeq

Call MainSequence in SignalGendnalyzeSeq.seq
Call MainSequence in AnalpzizCloseSeq. zeq

Call MainSequence in HwClozeSeq.seq



6.4.1.2

6.4.1.3

The sequence contains three sections, setup, main and clean-up. The setup section
configures the hardware parts in the PXI chassis for multi DUT handling. It is possible to
select if a LTE signal should be generated or not. The value is by default set to true but can
be switched off by setting the variable LteSigGen to False.

In the main part of the test sequence the LTE signal is generated (if enabled) according to
the different test models, see [1]. The signal from DUT is then analysed for each test model
according to [1]. In the example two measurement loops are performed. For each
measurement loop a unique configuration file and a test limits file is loaded.

When all measurements are done the HW used is closed.

Other sequences

Except the main sequences, a few other sequences are used.

Seqguence Comment

MainSequence

H8| PrellUIT Dizplays a dialog bow in which the oper..
PostUUT Dizplays a pazs, fail, error, or terminate. .
PrelUTLoop Test UUTz zallz this befare looping an ..

Figure 6-35: Test sequences before and after test

- PreUUT: For all new DUTSs to be tested a dialog box will appear where DUT serial
number can be written. Another dialog box demands the user to select which DUT input
to use (multiplexer input in the PXle-1082 chassis).

- PostUUT: Actions that will be done after the main test sequence. In this case a check is
performed to see if a self-calibration of the VST is necessary.

- PreUUTLoop: Actions to be done in the beginning of a new test session (one or several
DUTs to be tested in a sequence). In this case a check is performed to see if a self-
calibration of the VST in necessary.

Test Configuration

For each measurement loop a configuration file is read that contains the settings for the LTE
signal generation and analysis. The files can be found in ..\RBS Small Cell
LTE\Configuration. In this case two files are available but if the measurement loop is
increased the number of files should increase (if configuration parameters are changed).

The file is a pure text file where the parameter settings should be written. As shown below
each setting starts with the parameter name followed by a tab and then the parameter value.
A # sign can be used to add comments in the files. The parameter names cannot be
changed. Example from a file:

# Configuration of Carrier Frequency
CarrierFrequency 2132500000



6.4.1.4 Testlimits

For each measurement loop a test limit file is read for the LTE signal analysis. The files can
be found in .\RBS Small Cell LTE\TestLimits The results from the different measurements
are compared with the limits. The limits are grouped according to the different measurements
that are required for each test model.

The file is a pure text file where the parameter settings should be written. As shown below
each setting starts with the parameter name followed by a tab and then the parameter value.
A # sign can be used to add comments in the files. The parameter names cannot be
changed. Example from a file:

# OBW limits
OBW_Limits_TM1_1.Bandwith_High 6000000
OBW_Limits_ TM1_1.Bandwith_Low 4000000

6.4.1.5 VST Calibration
The decision whether if the VST calibration should be performed or not is based on the time
and temperature difference since the last calibration. Note: The VST self-calibration takes a
couple of minutes, do not interrupt the calibration when started.

6.4.1.6 Run the example
To run this example the GTT LTE RBS Toolkit needs to be installed. A NI PXle-1082 NI
chassis with a VST (PXle-5644R/5645R) and a multiplexer (PXle-2543) needs to be up and
running. The VST TX output needs to be looped to the CHOA and CH1A multiplexer inputs
since DUT control is not added in this example.

Select Execute -> Test UUTSs, a popup window appears:

B VST calibration check init o @ [

Checking if W5T calibration should be done...

Figure 6-36: DUT calibration check popup
Figure: DUT calibration check popup
Press OK to continue, a check is made to decide if a VST calibration should be performed.

If calibration is needed and started, the process must not be interrupted.



-

B \ST calibration info o @ /[

WET calibration needed!
Calibration will take several minutes and should not be interrupted,
Press Ok to start calibration,

Figure 6-37: DUT calibration popup
Wait for the popup telling that the calibration is done. Press OK.

This example supports the use of two multiplexer inputs. Select which input to use for the
DUT to be tested.

il Input Channel Select Msg E =] @

Select towhich channels on the switch Ple-2543 the UUT is cannected

Channel 1 A/ |

Figure 6-38: DUT input select
The DUT serial number can be written manually or with a BarCode reader.

Test Socket UUT Serial Humber

0

oK. | Stop

Figure 6-39: Enter serial number
Press OK to start test execution. The status bar to the right of the main sequence shows the

result for each step (done/pass/fail etc.). When the sequence execution is done, another VST
calibration check is made.

B \'ST calibration check init o @ /[

Test finished, remowe LT,

Start checking if WiT calibration should be done...

Figure 6-40: DUT calibration check popup



6.4.1.7

If calibration is necessary the DUT can be removed (in an application with DUT control)
during the calibration procedure. Press View Report to see results from the test in a
protocol. If another DUT is to be tested, press Next UUT and select the multiplexer input
used.

Test Socket UUT Serial HNHumber

444
0

Mext LT | | Wiew Repart....

Figure 6-41: Next DUT dialog

The DUT test report can also be stored in a custom database. If no more DUT will be tested,
press EXxit to stop execution.

Sequential /Parallel testing

Since this example is based on using one VST, the DUT testing will be sequential but the
multiplexer is making it possible to prepare the second DUT while the first one is tested.

6.4.2 Measurements

The LTE Small Cell test performs the following LTE signal measurements (see definitions in
section 6.1) for the different Test Models (TM):

For E-TM1.1: DLRS power, ACLR, Output power, OBW, SEM, Transmit ON/OFF power
E-TM1.2: ACLR, SEM

E-TM2: EVM, Frequency error

E-TM3.1: Output power, EVM, Frequency error, CCDF

E-TM3.2: EVM, Frequency error

E-TM3.3: EVM, Frequency error, CCDF, Spurious

6.4.3 Additional Functions

6.4.3.1

Interface DUT-control

Each DUT family to be tested may have different communication interfaces such as UART,
Telnet, VXI-11 etc. Gefle Testteknik can help you to extend the example above with your
specific DUT control.

6.5 Statistical Testing

Statistical testing is a big topic (see references [5] and [TBD]) which also involves processes
used at the factory floor. Please feel free to contact GTT for consultation before
implementing statistical testing in your production.



When producing high volumes of products with adequate design margins and process
control, there are a number of test cases that are not to be considered as “critical” and where
a deviation from the norm can be considered as causing minor impact at the customer.

When these types of measurements rarely fail they are to be considered as candidates for
sample test. By defining sample test in a way that maintains a high enough confidence level
regarding the possibility of complying with specifications, the test time can be reduced with
minimal risk.

Sampling methods can be implemented for all measurements that are not considered as
mandatory due to their critical nature, and sampling can be initiated when the margins of the
measurands are high enough to fulfil the sampling criteria.

Statistical testing is implemented in .NET assembly Gtt.Gnl.dIl. The classes Gtt.Gnl.Cpk and
Gtt.Gnl.Csp1l are used when creating sample plans for c,, and CSP-1.

6.5.1 Prerequisites
Before enabling sample test, certain criteria must be fulfilled:
e There is a consistent production flow

o There is only slow variation in volumes through test; if long periods without
new units occur, the sampling should be restarted.

e There is ample space, equipment and manpower on or near the site of test to permit
rapid 100% test when required

e All produced units must be produced according to the same design and specifications
e The process quality entering the test stage must be fairly high and controlled

e The test is non-destructive

6.5.2 Data Storage Requirements

Some type of data storage is required for keeping track of results and parameters for a
measurand. This data storage can be anything from just holding the data in-memory or in
text files on the local computer to multiple centralized file- and SQL servers. How exactly the
data storage is implemented varies between different companies and sometimes even
between different product families within the same company.

Retrieving data from previous measurements for a measurand should be at least an order of
magnitude faster than performing the actual measurement. Otherwise any reduction in test
time from sample based testing will be eaten up by the time taken to access the data
storage.

For each measurand it must be possible to retrieve the following data per station from data
storage:

e Time and date when measurements were performed. See 6.5.2.1 for detalils.

¢ Measurement results.



6.5.2.1

o For CSP-1 a passed or failed results are enough.
e Number of times the measurand has been skipped since last measurement.

Maximum Age

It must be ensured that the CSP-1 or ¢y is based on a short enough time span to represent
the current situation, meaning that samples older than the specified maximum age shall be
excluded from the calculation. This ensures that a response to a change in CSP-1 or cy is

fast enough.

6.5.3 AOQL and Risk Level

6.5.4

6.5.4.1

AOQL is expressed as a defective rate (fraction defective) in the GTT RBS Test Suite.

AOQL is the maximum or worst possible defective rate for the AOQ. Regardless of the
incoming quality, the defective rate going to the customer should be no greater than the
AOQL over an extended period of time. Individual lots might be worse than the AOQL but
over the long run, the quality should not be worse than the AOQL.

AOQL shall set to the highest risk level that can actually be accepted, meaning that in some
cases sampling might not be performed unless a better design margin can be achieved.

Cpk

C.k-based sample testing (i.e. testing based on the relation between the distance of the
mean of measurement results to the limit and the standard deviation of the measurement
results) is testing a fraction of the produced units, where the fraction is based on how well the
previously tested units fulfilled the limits.

If the ¢, is improved during sampling, the sampling frequency will be automatically changed
to match the new cy. If ¢y becomes lower it will automatically increase the sampling
frequency. This means that the sampling frequency is constantly calculated on the achieved
cpk and adjusted when required.

C,« is only valid for parameters that can be approximated to have a normal distribution. A
normality test of the applicable test cases shall be done prior to introducing cy-based sample
test. Test cases which fail the normality test must use CSP-1.

Class Gtt.Gnl.Cpk

See sections 6.5.3, 6.5.4.3, 6.5.4.1, and 6.5.4.4 for details about setting the arguments used
in the constructor or the properties.
public Cpk()

public Cpk(double aogql, int minSamples, int maxSamples, double
minSamplingFrequency)

public double Aoql { get; set; }

public int MaxSamples { get; set; }

public double MinSamplingFrequency { get; set; }
public int MinSamples { get; set; }



6.5.4.2

6.5.4.3

6.5.4.4

6.5.4.5

lowLimit and highLimit are the lowest and highest values allowed for passed result. These
values are used to calculate distance of the mean on measurements results and the
standard deviation of the measurement results.

The measurements collection is the historical data for the measurand to run c, analysis on.
This collection must be sorted descendenly by the time and date the measurements were
taken. This collection can contain fewer than MinSamples values or be empty. In both those
cases the result from the ¢, analysis will be that a measurement shall be performed.

skipCount is how many consecutive times the measurand has been skipped since the latest
measurement.

The cpkresult object returned contains the result of the cy analysis.

public CpkResult Analyse(double lowLimit, double highLimit, IEnumerable<double>
measurements, int skipCount)

Maximum Number of Samples

Maximum number of samples to include in the sample plan is used to avoid excessive test
over a long period of time due to singularities. If for example the test has failed in connecting
a transmitter port, and the power reading becomes 50 dB lower than normal, this will have a
large impact on the c for a long period of time unless its impact is limited.

e Singularities will in many cases lead to full test for the defined number of samples

e A singularity will only impact the sampling frequency for the defined number of
samples

Minimum Number of Samples

The cy calculation shall be based on a high enough number of units to enable as good ¢ as
possible but cannot be based on too many units if the sampling frequency becomes too low
since this will mean that the data to a very high extent is to be considered as historical, thus
not reflecting the current situation. Since the sampling frequency is to be updated based on
the calculated cy it is essential that it to a high extent reflects the actual spread of the
products currently being tested.

The recommendation is to set minimum number of samples to include in the calculation, to at
least 30 units to achieve any significance in the the calculated c. Sample based testing for
measurands will not start until there is at least this many samples available in the data
storage.

Minimum Sampling Frequency

Minimum allowed sample frequency sets a lower limit to the sampling frequency. The
sampling frequency will never drop below this value even if c,, and AOQL indicates a lower
sampling frequency.

Cpx Example Usage

This is a trivial example and it doesn’t show the usage of a database as data storage nor
does it remove old measurement due to age (see section 6.5.2.1).

Start with creating a C, object:



double aoql = ©.0001;

int minSamples = 30;

int maxSamples = 100;

double minSamplingFrequency = 0.05;

Cpk cpk = new Cpk(aogl, minSamples, maxSamples, minSamplingFrequency);

Set how many consecutive times the measurand has been skipped.

int skipCount = 2;

Specify limits required for a passed result. In this example the measurand doesn’t have a low
limit. To avoid the low limit from affect cy in a negative way it is set to
double.Negativelnfinity.

double lowlLimit = double.NegativeInfinity;
double highLimit = -75.0;

These are the results from previous measurements.

var data = new List<double>() { -77.686, -75.950, -74.504, -75.661, -77.107 };

Run the c, analysis.

CpkResult cpkRes = cpk.Analyse(skipCount, lowLimit, highLimit, data);

Check result of ¢y analysis and take appropriate actions. When a measurement is made, the
result of the measurement is added at the front of the list to keep the collection sorted by
decadently date, skipCount is reset to zero. When a measurement is skipped, the skip
counter is increased.

if (AnalysisResult.Measure == cpkRes.Result)

{
double sem = MeasureSEM(..);
data.Insert(@, sem);
skipCount = 9;

}

else

{
++skipCount;

}

6.5.5 CSP-1

CSP-1 is a single-level continuous sampling procedure which provides for alternating
sequences of 100% inspection and sampling inspection with no limit as to the length of such
sequences. This implementation is based upon the continuous sampling plans according to
MIL-STD-1235C [].

Since the margins in the measurand aren’t considered in CSP-1, it shall be used primarily for
test cases which don’t have parametric data with fairly normal distributions.



6.5.5.1

The drawback of this sampling procedure is that it always goes back to 100% test if a unit
fails, regardless of how well behaved the rest of the population is. If the incoming quality to
test is much better than assumed, the sampling frequency will not be affected since the
sampling frequency is given by the number of consecutive conforming units. The criterion is
just passed, without any information regarding the actual margin to the limit.

Class Gtt.Gnl.Csp1

SamplingFrequency is the desired sampling frequency. This value together with AOQL
controls how many consecutive measurements that must have a passed result before

sampling will start. See sections 6.5.3 for details about setting AOQL.
public Cspil()

public Cspl(double aoql, double samplingFrequency)
public double Aoql { get; set; }
public double SamplingFrequency { get; set; }

passedCount iS humber of consecutive measurements with passed result for the measurand.

skippedCount is how many measurements have been skipped since the last measurement,
taken for the measurand.

The return value from the Analyse method is whether the measurand shall be measured or
skipped.

public AnalysisResult Analyse(int passedCount, int skippedCount)

7 Abbreviations

4C-HSDPA Four-Carrier HSDPA. HSDPA operation configured on 3 or 4 DL carriers
8C-HSDPA Eight-Carrier HSDPA. HSDPA operation configured for 5 to 8 DL carriers

ACLR Adjacent Channel Leakage power Ratio

ACP Adjacent Channel Power

AOQ Average Outgoing Quality; the long run expected percentage of defective
material in the accepted material, if the associated sample plan is followed

AOQL Average Outgoing Quality Limit; AOQL is the maximum or worst possible
defective rate for the AOQ

API Application Programming Interface

ARFCN Absolute Radio Frequency Channel Number

AWG Arbitrary Waveform Generator

BCH B CHannel TBD

BER Bit Error Rate

BLER BLock Error Rate

BS Base Station

BTS Base Transceiver Station

CCDF Complementary Cumulative Distribution Function

CDP Code Domain Power

CDR Relative Code Domain Power



Cok Process capability index indicating the distance between the + 3o point of
the process spread to the limit lines

CHP CHannel Power
CPICH Common Pllot CHannel
CSP Continuous Sampling Plan

DB-DC-HSDPA Dual Band Dual Cell HSDPA
DC-HSDPA Dual Cell HSDPA

DL Down Link

DLRS DownLink Reference Signal

DUT Device Under Test

E-TM E-UTRA Test Model

E-UTRA Evolved UTRA

EVM Error Vector Magnitude

FDD Frequency Division Duplex

FRC Fixed Reference Channels

GMSK Gaussian Minimum Shift Keying
GSM Global System for Mobile communications
HSDPA High Speed Downlink Packet Access
HW HardWare

IQ in-phase and quadrature modulator
LTE Long Term Evolution

MIMO Multiple Input Multiple Output

MS Mobile Station

NC-4C-HSDPA Non-contiguous Four-Carrier HSDPA. HSDPA operation for two
non-adjacent blocks within a single band configured on 2, 3 or 4 DL carriers.

NI National Instruments Corporation
oBwW Occupied Bandwidth

OFRS Output RF Spectrum

P-CPICH Primary Common Pllot CHannel
P-SS Primary Sync Signal

PAR Peak to Average Ratio

PC Personal Computer

PLL Phase Lock Loop

PVT Power Verses Time

RB Resource Block

RBS Radio Base Station

RF Radio Frequency

RFSA RF Signal Analyser



RFSG RF Signal Generator

RNTI Radio Network Temporary Identifier

RRC Root Raised Cosine

S-SS Secondary Sync Signal

SCH Synchronisation CHannel

SEM Spectrum Emission Mask

SFP Soft Front Panel

SQL Structured Query Language

TAE Time Alignment Error

TDD Time Division Duplex

TDMS Technical Data Management Streaming
™ Test Models

TRX Transceiver

TXP Transmit Power

UE User Equipment

UART Universal Asynchronous Receiver/Transmitter
UMTS Universal Mobile Telecommunications System
USB Universal Serial Bus

UTRA UMTS Terrestrial Radio Access

UuT Unit Under Test

VI National Instruments Virtual Instrument
VST Vector Signal Transceiver

VXI-11 TCP/IP communication protocol
WCDMA Wideband Code Division Multiple Access
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Appendix A - 3GPP versions for LTE measurements

List of the versions of the 3GPP standard [1] used for each LTE measurement.

GTT Base | Transmit | Frequency | OBW | ACLR SEM RS TX | CCDF
LTE Station | ON/OFF Error Power

RBS Output Power

Toolkit | Power

revision

1.0.1 11.3.0 11.3.0 11.3.0 11.3.0 11.3.0 11.3.0 11.3.0 11.3.0

Appendix B - 3GPP versions for GSM measurements

List of the versions of the 3GPP standard [2] used for each GSM measurement.

GTT GSM RBS Modulation Transmit Output RF Power Versus
toolkit revision Accuracy Power Spectrum Time
1.0.1 11.2.0 11.2.0 11.2.0 11.2.0
Appendix C - 3GPP versions for WCDMA measurements
List of the versions of the 3GPP standard [3] used for each WCDMA measurement.
GTT Base EVM | Freq. | CDP | ACLR | OBW | SEM Peak | Relative
WCDMA | Station Error Code Code
RBS Output Domain | Domain
toolkit | Power Error Error
revision
1.0.1 11.4.0 1140 | 1140 | 1140 | 1140 | 11.4.0 | 11.4.0 11.4.0 11.4.0
Appendix D

Vs used for the SFP’s.




LTE

Generation

Trigger Config
Arb:Pre-filter Gain (dB)

resource Name &
I

LTE - 5G out

ref clock suurceJ :'-'r“lml
IQ Source Control E
Error in

DL Signal Setting se—m————

Generation File Path (ASC)
UL Signal Setting

&= Resource Element Maps
fee grror out

gttLTE - SG - VST - Initialize.vi

LTE - 5G in

error in (no error)
Gen Center Frequency
Average Power (dBrn)

LTE - 5G out

]

error out

OttLTE - SG.lvclass:gttLTE - SG - Generate.vi

LTE - 5Gin

LTE - 5G out

ﬁ ..........

i Gen erating

error in (no error)

b grror out

OttLTE - SG.Ivclass:gttLTE - SG -Error Check.vi

LTE- 5Gin

ﬁ ..........

LTE - 5G out
* Generating

error in (no error)

E= epror gut

OttLTE - SG.Ivclass:gttLTE - SG -Error Check.vi

Analysis

Advanced Settings
LTE Signal Setting

FESOUTCE NAME
clock source

RFSA Settings
error in (no error)
BS Settings
Enable

VST LTE - DL - 54 out

error out

gttLTE - DL - SA - Initialize .vi
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VSTLTE- DL - A In

Trace Display
error in (no error) ==

CCDF Traces

OBW Spectrurn Trace
LTE SEM

VST LTE - DL - 5A out

........ &= Measurements

j = ACP spectrum trace

error out

""""""" EVM Results
Constellation

OttLTE - DL - SA - Analyze.vi

Meas Type

WSTLTE - DL - SA—F.IHMVST LTE - DL - 54
. Lre)) RF54 data

error in (no error) b eprr out

gttLTE - DL - SA - Measure .vi

S CCDF Trace Data
| OBW spectrum trace
) przerzzzraen LTE SEM
WST LTE - DL - 54 " _________ WST LTE - DL - 54
Trace Display — T T e o7 = Measurements
Error in (no error) PL ACPIQ trace
j b ACP spectrum trace
Hramn error out
""""""" EVI Results
Constellation

gttLTE - DL - SA - Fetch Results .vi

VST LTE- DL - SA"""H
=
Lre))

error in (no error)

gttLTE - DL - SA - Close.v

error out

GSM

Generation

The following VI's are used for setting up and close the GSM signal generation:

External &ttenuation, dB
Level, dBm

RF5G Handle In
Frequency Reference .
Trigger Config ==}

EFTOT in

UTT settings

gttG5M-5G out

error out

GSM — SG - Initialize.vi
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gttGsM-5G in gttGSM-5G out
Signal )

Sample rate
error in (no error) ===
Generation File Path (ASCI)
UTT settings

i) error out

GSM - SG - Generate.vi

gttG5M-5G in ﬁ ................. = gttG5M-5G out
_ e “- Generating
Efrarin - b epror cut

GSM — SG - Error Check.vi

gttG5M-5G in mﬂ
axHM
£

Errar in . error ocut

GSM — SG - Close.vi

Analysis
Trigger
RF5A Handle ~- gttGsh-54 out
Frequency Reference = "
RFSA Settings srroreu
Error in
BS settings
GSM — SA — DL — Initialize.vi
gttGsM-54 in gttGsM-54 out
EFTCr in ! error out
GSM — SA — DL — Measure.vi
G5 PVT
PYT Measurement
gttG5M-54 in gttGEM-54 out
i = 350 EVIM
srrerin EVM Measurement
error out
ORFS Measurement
TP Measurement

GSM — SA — DL — Fetch Result.vi
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gttGSM-Su':'-. in “‘“‘H
=
GSrah\:’i

Error in

error out

GSM — SA — DL — Close.vi

WCDMA

Generation

The following VI's are used for setting up and close the WCDMA signal generation:

External &ttenuation, dB
Level, dBm

RF5G name

Frequency Reference =
Trigger Config =1

Error in

gttWCDMA-5G out

error out

WCDMA - SG — Initialize.vi

External Attenuation, dB
Level, dBm

gttWCDMA-5G in gttWCDMA-5G cut

Center Frequency, Hz w‘%ﬁm
Scramble Code

error in (no error)
Generation File Path (ASCI)
zarnple rate

Signal

error out

WCDMA - SG — Generate.vi

gttWCDMA-5G in H gttWCDMA-5G out
DA |- eoeeeeeevereenen . .
Fﬁ @ - Generating
o b error out

errorin

WCDMA — SG — ErrorCheck.vi

gttWCDMA-5G in ﬂ
i

Errorin

error out
WCDMA — SG - Close.vi
Analysis

The following VI's are used for setting up and close the WCDMA signal analysis:



Trigger

RF5A Handle ~- gttWCDMA-5A out
Reference Clock =
RFSA Settings error out
Errorin

BS settings

WCDMA — SA — DL — Initialize.vi

gttWCDMA-SA in gttWCDMA-S4A cut

WCQPA

Error in m error cut

WCDMA — SA — DL — Measure.vi

e SEM Waveform
f s SEM Measurement
Active Channels
gttWCDMA-54 in =e=es T = gttWCDMA-SA out
) ; 7H b= ModAce Measurement

EITOT I = =n hodfcc Constelation
Hi == OBW Measurement
CHP Measurement
el b error out
.. ------------- ACP Measurement
| ACP Waveform
N CDP Measurement

WCDMA — SA — DL — Fetch Results.vi

gHWCDMA-SA in —————H
WCDHMA
%51 A

Error in error out

WCDMA - SA — DL — Close.vi
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